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List of terms used in SALTO Integration
Module Configuration and Operation Manual

Access is a moving of users, transport and other objects into (out of) the premises, buildings, zones and territories.
Server is a computer with installed Server configuration of Intellect software package.

Client is a computer with installed Client configuration of Intellect software package.

Controller is an electronic device for control over access points.

Access control system (ACS) is a hardware-software complex for carrying out access control functions.

Readers are electronic devices for keyboard inputting the stored code or for reading code information from system keys
(identifiers).

Access point is a place where there is access control. Access point can be performed by the door, turnstile, gates, barrier
that are equipped by reader, electromechanical lock and other means of access control.

Access identifier is a key (physical or digital) using which one can access the premises, buildings, zones and territories.
Access card is a physical access identifier that is registered by reader.
Encoder is an electronic device for specifying access cards to users.

Time schedule - a set of any number of time intervals during a day (24 hours) defined for several days (1 to 366), and the
time intervals during specific dates. Time schedule defines a schedule of access to the secured object.

PPD (portable programming device) - device used for transferring data between Salto devices and computer.

SHIP (Salto Host Interface Protocol) is a protocol by which the SALTO ACS vendor software operates with the software of
third-party manufacturer.

Time schedule - a set of any number of time intervals during a day (24 hours) defined for several days (1 to 366), and the
time intervals during specific dates. Time schedule defines a schedule of access to the secured object.

Introduction into SALTO Integration Module
Configuration and Operation Manual

On the page:

® Purpose of document
® General information about SALTO
integration module

Purpose of document

Configuration and operation manual for the SALTO integration module is an informational reference manual intended for
use by configuration specialists and operators of the SALTO module. This module is a part of the fire and security alarm
subsystem (SALTO) implemented with the ACFA Intellect software package.

This Guide contains the following materials:

1. general information on the SALTO integration module;
2. configuration of the SALTO integration module;
3. operation of the SALTO integration module.

General information about SALTO integration module

SALTO integration module is a component of ACS that is carried out on the basis of ACFA Intellect software package. It is
for realization of the following functions:

1. SALTO ACS configuration (SALTO Systems is a vendor);
2. providing interaction between SALTO ACS and ACFA Intellect (monitoring, control).

Note.
For more information on the SALTO ACS system, refer to the official documentation on this system.

1 Attention!



The server of ACFA Intellect started on one computer and the software of the SALTO ACS vendor are essential for
operation of the SALTO integration module.

@ Note.

Remote control over the SALTO module can be performed from the Clients of distributed system that is
constructed on the basis of ACFA Intellect software package.

Before operation of the SALTO integration module do the following:

1. Install the SALTO ACS hardware at the guarded object (see the reference documentation on the SALTO ACS).
2. Configure the SALTO ACS in vendor’s software (see the official reference documentation).
3. Connect the SALTO ACS to the Server.

Supported hardware and licensing of the
SALTO integration module

Manufacturer Salto Systems, S.L., C/Arkotz 9 Pol. Lanbarren 20180, Oiartzun (Gipuzkoa)
info@saltosystems.com
Integration type SOFT-SOFT. Salto Access PRO.

Equipment connection Ethernet

Supported equipment

Equipment Function Features

CUS50EN On-line controller 2 reader connections
2 relay outputs
Maximum number of users per door: 64,000
Maximum number of doors in a system: 64,000

Maximum events on door controller: 300
Time zones: 256

Time periods: 30

Calendars in system: 256

Zones in system: 1,024

User groups: unlimited

Ethernet interface

CUS50ENSVN  On-line controller 2 reader connections
2 relay outputs
Maximum number of users per door: 64,000
Maximum number of doors in a system: 64,000

Maximum events on door controller: 300
Time zones: 256

Time periods: 30

Calendars in system: 256

Zones in system: 1,024

User groups: unlimited

Ethernet interface

Encoder Desktop reader Reading, encoding and updating cards

Protection
1 IP address. SHIP module is to be purchased as integration is performed using the SHIP protocol.

Configuration of SALTO integration module
Procedure for configuring of SALTO integration module

The SALTO integration module is configured through the following steps:

1. Configuration of SALTO ACS in vendor software.
2. Configuration of SALTO ACS connection to ACFA Intellect software package;
3. Downloading and recording of SALTO ACS configuration;
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. Assigning the access levels to users;

Specifying the SALTO ACS cards;
Configuration of the SALTO ACS doors;
Configuration of the SALTO ACS zones.

Configuration of SALTO ACS in vendor software
Procedure of configuring of SALTO ACS in vendor software

This chapter contains first steps for getting started the SALTO ACS. More detailed configuration has to be accomplished in
accordance with vendor manual.

After the SALTO ACS vendor software installation do the following steps:

APwWN =

Create a database.
Configure the SHIP port for data transfer.

Add the peripherals to the list.

. Configure the wireless locks if it is necessary.

Creatlng a SALTO ACS database

To create the SALTO database at the first startup of SALTO vendor software, do the following:
1. Start the SALTO vendor software.

2.

In the File menu, select New DB->New DB.

RW Pro-Access Connected SHIP
File Data Keys Peripherals Tools Help

g Mews DB J Mew DE

= Cpen DE [ Mew DB {migration Fram M3-Access DE)
ImparkExpart L

E Logif

Change language ¥ Eeores

[= Exit I

Eatnect PRI

3. From the Server drop-down list select database server name (1).

Create new DB x|

Ser

5 3 1
D al

SALTO_Rw )2
Senal Ma:

Connect using:

@ Windows authenticatinD 4
G’ S0L Server authentication 35

agit names:

Fazzward: ﬁ

W Ok x Cancel |




In the Database field, enter a new database name (2).
In the Serial No field, enter a product serial number or leave the field empty (3).
Set the Windows authentication checkbox if it's necessary to use Windows credentials (4).
If it's necessary to use SQL-server authentication do the following steps:
a. Set the SQL server authentication checkbox (5).
b. Enter the user login name and password (6).
8. To save changes click Ok (7).

Nowu s

The new database creation is completed.

Configuration of a SHIP port

To configure the SHIP port, do the following steps:

1. In the Tools menu, select Configuration -> General options.

RW Pro-Access For Service [WS3\SOLEXPRESS\SALTO_RW]
File Data Kews Peripherals | Tools Help

ﬂ fuditor i
Ly
!
issi » . . .
Doors Operatars and permissions levels Timed periodz Tin
(.'_% Scheduled jobs
[T Events streams
Make backup
E Card template list
Configuration nieral options
Local options
RF Cptions

S0L Server Configuration

2. In the opened Options window select the SHIP tab (1).

Options
General| L Lock | £ User % Feys 0 PPD | oy Online £z Vistars ﬂ SAM and issuing data | Advanced

SALTO zerver [SHIF): 1

Enabled ) 2

TCPAR part:

(o 33

HOST server (SHIP):
[ Enabled

C S C 8w ] o

3. Set the Enabled checkbox (2).
4. In the TCP/IP port field, enter the port number for data transfer via SHIP (3).
5. To save changes click Save (4).

SHIP port configuration is completed.

Adding peripherals

To add peripherals like controllers or gates, do the following steps:



1. In the Peripherals menu, select Peripheral list.

RW Pro-Access For Service [WS3\SOLEXPR

File Data Keys | Peripherals Tools Help

E B Moanitaring of anline locks

& Connect PRPD

Draars
B audit trai

@ RF Modes

2. To add the device click New.

Peripheral lisk _ Ol =|
f St Search [Description)
A BN = I Drezcription ﬂ I ﬂ
Dezcription IP addrezs Feripheral type
Szan on | Sigrial | Address | Addresz [FRD | Show fimmware |
ieyy details | [elete | =4 Frinit | [+ Close |

3. The Peripheral window opens.




Peripheral g
F Mame 1 Dezcription 2
! @ D C >
IP address

((000.000.000.000 3

I Peripheral type

t o, Ethemet encoder ;-D 4

@ [ Fun update reader
[ Enable beeper

)
= = I~ I 4 X (_ @é Save _)[ [+ Close ]

In the Name field, enter a name of added device (1).

In the Description field, enter information about this device (2).

In the IP address field, enter an IP address of device (3).

From the Peripheral type drop-down list, select a type of the connected device (4).
To save changes click Save (5).

Peripheral will be added to the Peripheral list (1).

Peripheral list =lol x|

O ONOU A

Sort Search [Description)
L I Diezcription j I ﬂ
[ escription IP address Feripheral type
Control unit ] ¥ Ethemnet anline contral unit

1
3

Signal |{ Address | ) Addrezs [PPD) | Shaw firmware |

[C, Wiew details | E Delete | & Print | [+ Cloze |

10. To set the connection to the online controller do the following:
a. Click Scan on (2).
b. Press tamper on the peripheral card (1).



c. Wait when the indicator near the tamper starts flashing (2).

(D Note.

Open the device case for access to temper.

&
d. Click Address (3). If the connection established, indicator will be displayed in the com. column.

EYreripheral list ) o ] 4
Sort Search [Description)
I Dregecription j I ﬂ
IP address Peripheral type
Caritrol unit 192.168.000.069 | Ethernet arline contral unit

Scan off | Signal | Address Address [FPD) | Show firmware |

Hew | [, Wiew details | [ Delete | &5 Frint | [+ Claze |

On default the Address button is inactive. To specify address select the Peripherals -> Monitoring of
online locks and set checkbox close to corresponding controller and click the Address button.
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Monitoring of online locks

[ Manitoring | Lockdown | Maintenance |

= S [m] 3

|'Name | Com, | Description | | Hostname | Tamper | Battery

- ¥ Controller 5] 10.0,11.192 [7]

TOTAL: 1

b tpdate |
[ shonfmware |
[ addressorn) |

|' Signal |

| @ Connection established correctly

Adding a peripheral is completed.

Configuration of wireless locks
Procedure of configuring wireless locks

Configuration of the wireless locks in the SALTO ACS vendor software is done in the following order:

1. Wireless locks activation in the system.
2. Wireless locks creation.
3. Wireless locks initialization.

Wireless locks activation in the system
To use the wireless locks, set the SALTO ACS vendor software as follows:

1. In the Tools menu, select Configuration -> General options.
2. Select the Advanced tab (1).




Options

General| M Lock | B User % ez o PPD | w2 Online | SHIP | g Vistors ﬂ SaM and issuing dataf Ad '?-

To be uzed by advanced operators only.
Advanced parameters Available parameters

FROX ANTICLONING=1 ASSIGN_CARDS_AUTOMATIC
= AUTO_LOGOFF_TIMEOUT
<@ 3 CHECK_USER_Ca&RDID
CUSVMN_DATE_EXT
DORM_KEYFAD
ExIT_LEAVES_OPEN
FREE_ASSIGHMENT_LOCKER
IMHIBIT_USER_MAME_CHANGE
I15_DEFARTMEMTAL
KEY_ISSUING
LIMITED_OCCUPANCY
LOCATION_FUMCTION_MATRIX
LOCKDO'H_EMABLED
MORE_THAM_B4K_LISERS

Wi
SHOW_EXT_ID
SHOWw_KEY_DETECT_MODE
SHOWw_ROM_CODE
SWN_TIMEOUT
USE_PRIVILEGES

- 5
[ &5 Print ] (_ [ Clase w

3. In the Available parameters list select the RF_ENABLED object and double click it (2).
4. Parameter will be added to the Advanced parameters list (3).
5. Click Close to hide the Options window (4).

As a result of wireless locks activation the RF-lock door type can be specified in the door settings (see chapter Wireless
lock creation).

The RF-locks switching is completed.
Wireless lock creation

For wireless locks creation, do the following steps:

1. Click the Doors button.
RW Pro-Access For Service [WS3\SOLEXPRESS\SALTO_RW]

File Data keys Peripherals Tools Help

1} HE 4 ¢C

Croors Zones Ilzers Ilzer access levels

2. The door list opens. Click New.
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Sort

| Increazed open ime A | | %
Updal Hame Description B attem B attery statusz date
»
%)) >
IC_ Hew j ’ [, Wiew details ] | B Delete | ’ &h Frint ] ’ [+ Close ]

3. In the Name field enter the wireless lock name (1).

Door
Open mode and periods
Open mode
Standard v |
Name
F-lock 1
Description

| | Connected door

115 online
Open time [zec] Increazed open time
| 10| 20
Calendar
| Calendar0nn v|

Antipasshack Al Zones | & Automatic outputs

Enable antipasshack,

(=) From outside to inside
() From inzide to outside

Audit on keyps

[l Zones

[#] &udit inside: handle opening
[ &sdmit expired keys

[ ]

Lock state

ko

“alid Lintil

Update required

Firmware: ]

B | N

3

= :
[E]
=

M 4 = = o+ X

Access levels and users that access thiz door

X

(g Timezones

B

4. Set the Is RF checkbox (2).
5. Click Save to save changes (3).

Wireless lock will be added to the door list.

Wireless lock creation is completed.

Wireless locks initialization

Wireless locks are initialized through the following steps:

1. Connect PPD to USB-port.



2. Click Connect PPD.The PPD connection window opens.

R'vh' Pro-Access Connected SHIP [W5S3'SOLEXPRESS \SALTO_RW]
File Data Kews Peripherals Toaols Help

m s 4 i

D'oor= £ones |zersz |zer access levels
r: _‘  m—
e - ig

Timed periods Timezones Calendar Connect PPD Audit trail

3. Set the Initialize locks checkbox in the PPD connection window (1).

PPD connection ll
LFFD | Dowr | Status | Walid unti | 2
r T T - .
[ 108 I Update required ? J Search
[ 109 I Update required ? I ﬁl
[ 110 I Update required ?
[ 20 I Update required ? 'l tl
[ 202 lf Update required s
[ 203 I Update required ? Save az PFD order |
[ 204 I Update required ?
[ 205 I Update required ? PED
) B -
[ 208 I Update required 7 .statu
[ 207 I Update required ? Hersion [1.00
B 208 ', Update required ? Senal number 1.000.0016
% 209 'r Ipdate required ? Fact. date 26/04/2002
[ 210 I Update required ? Battery Figh [I3
[*® Back Office lf Update required i L Enaish
[*® Caszino lf Update required i anquage tngis
[ elewator 1 lf Update required i DMemory [kb] 128 128
[ elewator 2 I Update required ?
[¥ mait entrance I Update required ? 0z |
[¥ Restaurant I Update required ? e — |
[ Swirriing pool I Update required ? - g et
Select doars————— 3
Select Al | C & Download )
Select pending doors | [ Close |
Deselect all |
Total: 27

= - L — —— = ] = ——————

(D Note.

If the Initialize locks checkbox is not set, then the INITIALIZE LOCKS object is not available in the
PPD menu.

4. Select the connected wireless locks (2).

(D Note.

It is not essential to initialize all doors simultaneously but it’s not recommended to postpone the door
initialization.

5. Click Download (3). Wait while the data transfer to PPD will be completed.
6. Disconnect the PPD from the USB-port.
7. Turn on PPD and go to the device main menu.
8. In the PPD menu select INITIALIZE LOCKS.
9. In the PPD menu select the name of the initialized lock.
10. Connect the PPD to wireless lock.
11. Wait for the sound signal. It means that the lock receives information from PPD and gives its identifier to PPD.
12. Disconnect the PPD from the wireless lock.
13. Repeat steps 8-12 for all locks to be initialized.
14. Connect the PPD to the USB-port.
15. Click Connect PPD. Information about locks is sent to the software. Locks are connected to the gate.

Wireless locks initialization is completed.

Configuration of SALTO ACS in ACFA Intellect software
package



Configuration of SALTO ACS connection to ACFA Intellect
software package

Configuration of the SALTO ACS connection to ACFA Intellect software package is performed on the setting panel of the SA
LTO Server object. This object is created on the basis of the Computer object on the Hardware tab of the System
settings dialog box.

= LOCALHOST [0-VOROBYOVA]

OBopynosaHWe Monssosatend

Read device configuration ]

e —— |
Computer Otk AfMUTE
l Save configuration ]
LOCALHOST hd
l Reconnect ]
Server IP
e 2r. o0 .0 .1
Server port 1]
Listening part

Nurber of read events

[ Use external ID far Tk
Trace changes in ACS

User advanced settings

Default encoder

SALTD Encoder 1.1 =

MpHMEHUTE CrmmeHnTs

To configure the connection of SALTO ACS to ACFA Intellect software package do the following:

1.

Go to the setting panel of the SALTO Server object.

1 SALTO Server 1 [ Fiead device configuration l

Carmputer 0Tk AHHMTE [

Save configuration l
LOCALHOST A

[ Reconnect l

Server [P
Y. 127 .0 .0 1

Server port i}

Liztering port

=1
- LW M =

Mumber of read events

[T Use extemal ID for Tak | &
Trace changes in ACS |

| Uszer advanced settings ]

Default encoder

I S&LTO Encoder 1.1 - I 7

. In the Server IP-address field set the IP address of computer on which SALTO ACS software is installed (1).
. In the Server port field set the TCP/IP port address of SALTO integration module connection to SALTO ACS softwar

e which is designed for transferring data by SHIP-protocol while configuring the vendor software (2).

. In the Listening port field set the port to which the queries of SALTO ACS software will be forwarded (3).
. In the Number of read events field enter the number of events read from the SALTO ACS software for one

system query (4).

. Set Use external ID for TAM checkbox to use external user ID while searching users for getting information about

passes (5). If checkbox is not set the user ID in the Intellect software package will be in use.

. Set Trace changes in ACS checkbox for automatic forwarding of user changes, time schedules and access levels

to SALTO ACS software (6).

. From the Default encoder drop-down list select the encoder which will be used on default (7).
. To save changes click Apply (8).

Note.
To cancel changes click Cancel.

Configuration of SALTO ACS connection to ACFA Intellect software package is completed.

14
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Downloading and saving of SALTO ACS configuration

Downloading of SALTO ACS configuration is performed on the setting panel of the SALTO Server object.

1 SALTO Server 1 Fiead device configuration 1
Carmputer Tk AHHMTE

S ave configuration 2
LOCALHOST hd

Reconnect 3

Server [P
VN 127 .0 .0 1
Server port i}
Liztening port

Mumber of read events

[]Use extemal 1D for TAM
Trace changes in ACS

User advanced zettings

Default encoder

S4LTO Encoder 1.1 hd

MpuMeHn T OmeHuTe

To download SALTO ACS configuration click Read device configuration (1).

As a result new objects appear in the object tree of ACFA Intellect software package.

Fo ¥ KoMAeHITER WSS [WE3]
= B8 KomMneroTep WSd [WSd]
= & SALTO Server 1 [1]
D SALTO DoorfReader 1 [1.1]
E SALTO Encoder 1[1.1]

To record configuration in SALTO ACS software click Save configuration (2).

Note.
Depending on configuration of SALTO ACS vendor software users access cards updating can be necessary after
configuration record (see chapter Assigning access cards of SALTO ACS).

To connect to the SALTO ACS software again click the Reconnect button (3).

Extended configuration of SALTO ACS user access level in ACFA
Intellect

SALTO ACS software package allows specifying access levels separately for all registered users in the controller system or

zone through the following steps:

1. Go to the setting panel of the SALTO Server object.
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W N

4.
5.

0]

1 SALTO Server 1 Fiead device configuration l

Computer OTEAUMTE

g . Save configuration l
LOCALHOST |

Reconnect l

Server [P
address LR

Server port i}
Liztening port

MHumber of read events

[ Usze extemal ID far TAM
Trace changes in AC5

Uzer advanced settings

Default encoder

|SALTO Encoder 1.1 =

MpumeHnTE OmeHuTe

Click User advanced settings.
The Advanced user settings window opens.
SALTO DoorfReader 1| SALTO Zone 1

ser 1 Full access

\. 1

Select the required access level through the peripheral in the appropriate drop-down list for all registered users (1).
To save changes click Apply (2).

Note.
Click Cancel to close Advanced user settings window without saving changes (3).

Access levels are assigned to users.

Assigning access cards of SALTO ACS

Assigning access cards of SALTO ACS is performed on the setting panel of the SALTO Encoder object. This object is
created on the basis of the SALTO Server object while downloading SALTO ACS configuration (see chapter Downloading
and saving of SALTO ACS configuration of this documentation).
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[T [SALTO Encoder 1

SALTO Server W il
|SALTO Server 1

Full Kame
User 1

r Refrezh card

Cancel card

1 Attention!
* Assigning access cards of SALTO ACS is impossible in case when the Encoder object is created manually in ACFA
Intellect software package.

To assign access cards of SALTO ACS do the following:

1. In the Card-waiting period, s field set time (in seconds) that specifies the time interval after clicking Assign card
or Refresh card and that is for bringing access card to encoder (2).

(D Note.

In the Name field the name of encoder object in SALTO ACS software is specified (1).

(D Note.

In the 3 field the users created in ACFA Intellect software package are displayed (3).

2. To assign the access card to the user select necessary user in the 3 field click Assign card and bring the access
card to the encoder during the period specified in the Card-waiting period field (4).
Attention! For correct access cards’ assigning it’s necessary to register users without using Russian
symbols.

3. To assign the new access card to the user select necessary user in the 3 field click Refresh card and bring the
access card to the encoder during the period specified in the Card-waiting period field (5).

4. To cancel the access card to the user select necessary user in the 3 field click Cancel card (6)

5. To save changes click Apply (7).

(D Note.

To cancel changes click Cancel (8).

Assigning access cards of SALTO ACS is completed.

Configuration of SALTO ACS doors

Configuration of SALTO ACS doors is performed on the setting panel of the Door/Reader object. This object is created on
the basis of the SALTO Server object while downloading SALTO ACS configuration (see chapter Downloading and saving of
SALTO ACS configuration of this documentation).
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[T1 " [3ALTO Door/Reader 1

SALTO Server B Ciainl=

(SALTD Server 1

M_

To configure SALTO ACS doors do the following:

1. In the Name field set the name of the door (1).
2.
3. In the Door open time field set time (in seconds) that specifies the time interval from the moment of door opening

In the Description field set the description of the door (2).

by the user till the moment of its automatic closing (3).

. Set the Record events to card checkbox if it's necessary to record Access forbidden and Access permitted eve

nts to the access card of the user who showed (4).

. From the Enter drop-down list select the Partition object name corresponding to the area which is located in the

site of exit through this door (5).

. From the Exit drop-down list select the Partition object name corresponding to the area which is located in the

site of enter through this door (6).

. From the Antipassback drop-down list select the value to enable or disable the antipassback (6).
. To save changes click Apply (6).

Note.
To cancel changes click Cancel (7).

Configuration of SALTO ACS doors is completed.

Configuration of SALTO ACS zones

Configuration of SALTO ACS zones is performed on the setting panel of the SALTO Zone object. This object is created on
the basis of the SALTO Server object while downloading SALTO ACS configuration (see chapter Downloading and saving of
SALTO ACS configuration).



nterfaces; SE[S; .: ” - nrr !P

-3 KomneroTep WS3 [W53]
Elﬂ KoMneroTep W4 [Ws4] - ISALTD Zone 1 E:E:'O A
= A SALTO Server 1[1] SALTO Server B Uil ooreate

- D SALTD DoorReader 1[1.1]
&l IO Forode ,1]

BB 5ALTO Zone 1[1.1]

[54LT0 Server 1

To configure SALTO ACS zones do the following:
1. Go to the setting panel of the SALTO Zone.

11 [58LTO Zone 1

SALTO Server B Uiz ble
([54LT0 Server 1

@—

In the Salto name field enter the zone name which will be specified to the object in SHIP (1).
In the Description field set the description of the zone (2).

Select doors which are included in configurable zone (3).

To save changes click Apply (6).

nhwn

Configuration of SALTO ACS zone is completed.

Operation of the SALTO integration module

General information about SALTO module operation

The following interface objects are used in order to operate the SALTO integration module:

1. Card;
2. Event log;
3. Visitor Management System.

Information about these interface objects setting is given in the Intellect™ Software Package Administrator's Guide and in
the Visitor Management System Module Settings and Operation Guide.

19


https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=84354171
https://doc.axxonsoft.com/confluence/display/acfaen/Visitor+Management+System+Module+Settings+and+Operation+Guide
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Operation of interface objects is given in details in the Intellect™ Software Package Operator's Guide.

SALTO door control

Door control of the SALTO integration module is performed in the interactive Map window through the functional menu of
the SALTO Door object.

SALTO Door/Reader 1[1.1]

Ernergency apen
End emergency
Emergency close
Cpen door

Functional menu description of the SALTO Door object:

Functional menu Performed function

command
Emergency open Emergency door opening. After emergency door opening the door is not closed automatically.
End emergency Emergency door mode changes to normal.

Emergency close Emergency door closing. After emergency door closing the door is blocked and closed and can’t be
opened.

Open door Door opening. After it door will be automatically closed in time specified in the Door opening time
field (see chapter Configuration of SALTO ACS doors).


https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=86474942
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